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Abstrakt
Předmětem bakalářské práce je vypracování rešerše k přepočtům fáze na hodnoty suché
hmoty buňky a provedení experimentů, které ověřují význam suché hmoty buňky. Teore-
tická část pojednává nejdříve o historii holografické mikroskopie a vývoji holografie na ÚFI
FSI VUT v Brně. Dále se zabývá transmisním holografickým mikroskopem. Je zde uveden
stručně jeho konstrukční popis a základní instrukce pro práci s tímto mikroskopem. Poté
je v teoretické části pojednáno o významu obrazové fáze. Jsou zde uvedeny dva přístupy
k interpretaci fázového zpoždění a také je zde vypracována rešerše k přepočtům fáze na su-
chou hmotu buňky (podle H. G. Daviese a M. H. F. Wilkinse, G. Popescua, G. Dunna
a D. Zichy). V experimentální části je nejdříve popsána kultivace buněk, poté příprava
vzorku pro pozorování a následně zpracování dat. Druhá polovina experimentální části
je zaměřena přímo na provedené experimenty. Ve všech experimentech byly pozorovány
buňky K2 (plné označení LW13K2). Nejdříve byla pozorována nutriční deprivace buněk
a poté buněčný růst.

Summary
Subject of this bachelor’s thesis is to create an overview of conversions of phase profile to
the values of dry mass and to realize experiments verifying the importance of dry mass.
In the theoretical part, the history of the holographic microscopy and the development
of the holographic microscopy on IPE FME BUT in Brno are summarized. The transmis-
sion holographic microscope is also described. This thesis covers its construction descrip-
tion and basic working instructions. The theoretical part also deals with the importance of
image phase. Two approaches are presented for the interpretation of the phase delay and
there is research on phase conversions to dry cell mass (according to H. G. Davies and M.
H. F. Wilkins, G. Popescue, G. Dunn and D. Zicha). In the experimental part cultivation
of cells, preparation of observation sample and processing of data are described. This part
of thesis is also focused on laboratory experiments. Cells K2 (full name LW13K2) were
observed in all experiments. First experiments deal with nutritional deprivation of cells
and later with cell growth.

Klíčová slova
Holografická mikroskopie, fázové zobrazení, ekvivalent suché hmoty, buněčný růst, nutriční
deprivace buněk.

Keywords
Holographic microscopy, phase imaging, equivalent of dry mass, cell growth, nutritional
deprivation of cells.
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1. ÚVOD

1. Úvod
Pěstování a pozorování buněčných kultur i samotných buněk je nedílnou součástí

výzkumu, diagnostiky i léčby. Uplatňuje se v genovém inženýrství, v biotechnologiích,
ve farmaceutickém průmyslu, při přípravě očkovacích protilátek apod. Ačkoli se nejedná
o novinku, je toto odvětví stále rozvíjející se a přínosné.

Snaha o pozorování malých objektů a jejich struktur, které nejsou pouhým okem vi-
ditelné, vedla k vývoji optických mikroskopů. Zobrazování ve všech typech mikroskopů
vzniká interferencí přímého světla (nerozptýleného vzorkem) a světla rozptýleného vzor-
kem. Protože některé objekty jsou mikroskopem dobře viditelné a další nikoliv, jsou ob-
jekty rozděleny podle interakce světelné vlny a objektu na dvě skupiny: amplitudové a fá-
zové. Objekty amplitudové mění amplitudu procházejícího světla, objekty fázové mění
fázi světla.

V biologii se lze často setkat s transparentními vzorky (buňkami), které málo roz-
ptylují a odrážejí světlo, a proto se řadí mezi objekty fázové. Aby bylo možné pozorovat
živé buňky, včetně jejich pohybů a reakcí na vnější prostředí, je nezbytné je uchovávat
ve fyziologických tekutinách (fyziologický roztok, kultivační média). K samotným pozo-
rováním se používají speciální kultivační komůrky v různém provedení a modifikacích
(například komůrky stacionární a průtokové). Při zkoumání v běžném optickém mikro-
skopu, který nedokáže zaznamenat přímo změnu fáze, je jejich obraz málo kontrastní
v porovnání s pozadím světlého pole. Pro zvýšení kontrastu se používá barvení nebo spe-
ciálních mikroskopických zobrazovacích metod, jakými jsou například metoda klasického
fázového kontrastu či interferenční mikroskopie. Ve fluorescenční mikroskopii, v interfe-
renční mikroskopii a v klasickém fázovém kontrastu se využívá toho, že médium, buňky
a jejich jednotlivé části se liší indexem lomu, který společně s tloušťkou vzorku ovlivňuje
fázi procházejícího světla.

Interferenční mikroskopie

Interferenční mikroskopie je zobrazovací metoda, která využívá interference světelných
svazků procházejících předmětovou a referenční větví. Díky záznamu interference a vy-
hodnocení interferenčního obrazce lze stanovit zpoždění předmětového světelného svazku
(rozdíl fází interferujících vln) způsobené průchodem přes objekt.

Interferenční mikroskopy lze rozdělit do dvou skupin podle úhlu, který svírá předmě-
tový a referenční svazek ve výstupní rovině. V případě, kde je tento úhel nulový (resp.
téměř nulový) a paprsky se scházejí v ose (in–line), jedná se o interferometrické mikro-
skopy. K získání úplné informace o předmětové vlně, tj. o její amplitudě a fázi, je nutné
zaznamenat více snímků lišících se definovaným fázovým posuvem. Jestliže je tento úhel
nenulový, pak se jedná o mimoosovou interferenci (off–axis) a mikroskopy se nazývají
holografické. Z jediného snímku (hologramu) je možné získat kompletní informaci o před-
mětové vlně [1].

Dále lze interferenční mikroskopy rozdělit na mikroskopy reflexní a transmisní. V pří-
padě reflexních mikroskopů se světelný svazek od vzorku odráží. Tento typ mikroskopů
se používá ke zkoumání povrchů (topografie). V případě transmisních mikroskopů světelný
svazek vzorkem prochází a je vhodný k biologickým aplikacím [2].
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Výhodou interferenční mikroskopie je, že pozorování probíhá bez barvení, tzn. bez to-
xických efektů pro živou buňku, což umožňuje v reálném čase pozorovat změny v buňce.
Velikost změny fáze závisí na tloušťce buňky a rozdílu indexu lomu buňky a média. Zá-
roveň je velikost změny fáze přímo úměrná množství suché hmoty a je tedy možné buňky
opticky vážit nebo vyhodnocovat změny hustoty vnitrobuněčné hmoty [3]. Tyto změny
jsou v relaci s ději, kterými buňka během buněčného cyklu prochází. Příkladem takového
děje je buněčný růst nebo dělení.

K experimentům této práce byl použit transmisní holografický mikroskop, a proto je
v následujících kapitolách psáno pouze o této skupině interferenčních mikroskopů.

Další použité metody

Další metody byly v rámci bakalářské práce použity pro vizuální kontrolu buněk před
zahájením snímání. Jednalo se o klasický fázový kontrast a diferenciální interferenční
kontrast.

Klasický fázový kontrast

Klasický fázový (Zernikův) kontrast využívá interference světelné vlny, která prochází ob-
jektem beze změny (nultý difrakční řád) a vlny, která je objektem difraktována (ostatní
difrakční řády). Světelný svazek nejdříve prochází kondenzorovým mezikružím, a tím
vzniká dutý světelný kužel. Po průchodu kondenzorem světelný svazek prochází vzor-
kem, kde jedna část prochází bez difrakce a druhá je objektem difraktována. Obě vlny
dále procházejí objektivem a fázovou destičkou (ve tvaru mezikruží) umístěnou v zadní
ohniskové rovině objektivu. Fázová destička posouvá fázi světelné vlny rozptýlené objek-
tem vůči nerozptýlené světelné vlně. Následně jsou oba svazky fokusovány do obrazové
roviny, kde dochází k interferenci. Rozdíly fáze se projeví kontrastní změnou intenzity
(amplitudy).

Nevýhodou klasického fázového kontrastu je existence halo efektů. V důsledku lomu
světla na stěnách objektu vzniká jasné záření, které znemožňuje určit přesnou hranici
mezi objektem a okolím. A právě detekce okrajů buňky je důležitá pro studium buněk [4].

Diferenciální interferenční kontrast

Nomarského diferenciální interferenční kontrast (DIC) převádí rozdíly v optické dráze
na rozdíly intenzity pomocí dvou modifikovaných Wollastonových hranolů. První Wollas-
tonův hranol slouží jako dělič polarizovaného světelného svazku. Rozdělené svazky s vzá-
jemně kolmými rovinami polarizace dále procházejí optickou soustavou blízko sebe, ale
v jemně odlišných směrech. Po průchodu vzorkem a optickou soustavou jsou světelné
svazky skládány dohromady druhým Wollastonovým hranolem. Po průchodu světelných
svazků analyzátorem (zajišťuje stejnou polarizaci světelných svazků) dochází k interfe-
renci. Vzorek je pozorován s viditelnými rozdíly v intenzitě.

Výhodou metody DIC je dobré rozlišení a nepřítomnost halo efektů. Nevýhodou je
vznik silně zářících parazitních obrazů, které vznikají při zobrazování dvojlomných vzorků.
Přesto není v biologických experimentech tato metoda příliš využívaná, jelikož většina
kultivačních materiálů je vyrobena z dvojlomných látek (např. Petriho miska), které při
pozorování touto metodou silně září [5].
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1. ÚVOD

Cíle a rozdělení práce

Prvním cílem této práce je vypracovat rešerši způsobů přepočtu fázového posuvu v buňce
na ekvivalent suché hmoty a kriticky vybrat jeden ze způsobů přepočtu, který bude dále
ve výpočtech této práce používán. Dalším cílem je provedení odpovídajících experimentů
za použití digitálního holografického mikroskopu v transmisním módu. Tento mikroskop
měří fázové zpoždění způsobené průchodem světelného svazku transparentním objektem,
a proto se hodí k měření rozložení ekvivalentu suché hmoty v buňce.

Samotná bakalářská práce, nesoucí název Měření rozložení ekvivalentu suché hmoty
buňky kvantitativním fázovým kontrastem koherencí řízeného holografického mikroskopu,
je rozdělena do tří částí. V první části je pojednáno o holografické mikroskopii od její
stručné historie až po konstrukční popis konkrétního holografického mikroskopu na ÚFI
FSI VUT v Brně a zpracování hologramu. Druhá část je zaměřena na význam obrazové
fáze a přepočty fázového posuvu na hodnoty ekvivalentu suché hmoty. Poslední, třetí
část se věnuje samotným experimentům (nutriční deprivace buněk, růst buněk), které
ověřují význam ekvivalentu suché hmoty jako důležitého parametru udávající informaci
o buněčném růstu.
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2. Holografická mikroskopie
2.1. Historie

Holografie (z řeckého holos – úplný a grafie – záznam) vychází z principu holografic-
kého zobrazení objeveného v roce 1948 D. Gáborem, který za položení těchto teoretických
základů získal v roce 1971 Nobelovu cenu. Přestože holografická (resp. interferenční) mik-
roskopie jako jediná umožňovala zobrazit i změřit rozdíly optické dráhy, nebyla doceněna.
Další vývoj nastal po roce 1952, kdy H. G. Davies a M. H. F. Wilkins publikovali, že roz-
díly optické dráhy jsou přímo úměrné množství suché hmoty objektu [3]. Následná etapa
přišla s objevením laseru v roce 1960, kdy T. H. Maiman poprvé předvedl laser jako kohe-
rentní zdroj monochromatického záření. Pro holografickou mikroskopii je laser ideálním
světelným zdrojem, díky své dlouhé koherenční délce. První trojrozměrný záznam, jehož
motivem byl vlak, se podařilo vytvořit vědcům na michiganské univerzitě pod vedením
E. Leitha a J. Upatniekse v roce 1964 [6].

I přes tyto pokroky nebyla holografická (resp. interferenční) mikroskopie prakticky
využívaná kvůli složitému uspořádání, vysoké pořizovací ceně a také proto, že nebyla
možnost ukládání a zpracování velkého množství dat. Pro běžné pozorování buněk bylo
používáno jiných mikroskopických metod (klasický fázový kontrast, diferenciální interfere-
nční mikroskopie atd.). Až rozvoj výpočetní techniky a digitálního záznamu oživil zájem
o holografickou mikroskopii. Dnešní digitální holografické mikroskopy (DHM) obsahují
kromě optické soustavy i digitální detekční zařízení a jsou propojeny s počítačem, který
umožňuje okamžitý záznam a zpracování hologramu.

V dnešní době jsou holografické mikroskopy používány ve výzkumných centrech pro
různé biologické aplikace, avšak v běžné medicínské praxi se zatím příliš nevyužívají [5].

2.2. Vývoj holografie na ÚFI FSI VUT

V Laboratoři optické mikroskopie na ÚFI FSI VUT v Brně byl první holografický mikro-
skop zkonstruován R. Chmelíkem a Z. Harnou [7]. V roce 1999 v rámci svých diplomových
prací začaly vyvíjet transmisní holografický mikroskop I. Chytková [8] a M. Prokopová
[9]. Později v rámci doktorského studia M. Prokopové byl vytvořen první prototyp [10],
na který navázal svoji prací P. Kolman. V rámci své dizertační práce P. Kolman [1]
navrhl a zkonstruoval transmisní holografický mikroskop s mimoosovým achromatickým
a prostorově invariantním interferometrem (dále jen CCHM, z anglického Coherence-Con-
trolled Holographic Microscope). Celkové schéma CCHM je na obrázku 2.1 a fotografie
holografického mikroskopu používaného v laboratoři Experimentální biofotoniky na ÚFI
FSI VUT v Brně je na obrázku 2.2.

Tento mikroskop je neustále vyvíjen (konstrukčně i softwarově) a je v současnosti
používán k pozorování biologických vzorků, především životních cyklů buněk a buněčné
dynamiky. Pro biologické aplikace je mikroskop vybaven termoizolačním boxem, který je
vyhříván buď proudícím vzduchem nebo dvěmi topnými systémy, jenž ohřívají podsta-
vec pod mikroskopem a posuvný stolek. Ohřívání termoizolačního boxu zajišťuje stabilní
teplotu během pozorování. Tento mikroskop byl použit i k experimentům této práce.
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Obrázek 2.1: Celkové schéma holografického mikroskopu vytvořené P. Kolmanem [1].

Obrázek 2.2: Fotografie holografického mikroskopu v laboratoři Experimentální biofoto-
niky na ÚFI FSI VUT v Brně.
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3. Mikroskop CCHM
3.1. Konstrukční popis mikroskopu CCHM

V dizertační práci P. Kolmana je konstrukční popis CCHM proveden do detailů, a proto
v této práci je optické uspořádání pouze nastíněno. Základní schéma optického uspořádání
je uvedeno na obrázku 3.1. V základním rozdělení se mikroskop CCHM skládá ze stejných
částí jako klasický optický mikroskop, a to z osvětlovací a zobrazovací soustavy a detek-
toru. Zásadní rozdíl CCHM od běžného optického mikroskopu je existence dvou větví,
které jsou opticky ekvivalentní a zrcadlově symetrické. Každá z těchto větví obsahuje dva
shodné objektivy.

Osvětlovací soustava se skládá ze zdroje světla, matnice (M), clonek (C), interferen-
čního filtru (IF) a objektivu (O). Zdrojem bílého světla je halogenová lampa. Výběrem
clony se určuje prostorová koherence světla. Při použití clony s menším průměrem se
dosáhne vyšší prostorové koherence, a tím i lepší interference, ovšem sníží se tím intenzita
osvětlení.

Za clonou je umístěn výměník filtrů, ze kterého je možné vybrat jeden z interferenč-
ních filtrů. Obvykle je používán filtr s maximální propustností na vlnové délce 650 nm
a s pološířkou maxima propustnosti 10 nm. Červené světlo je vhodné pro zkoumání biolo-
gických objektů, protože má nižší energii než bílé světlo, a protože je biologickými objekty
málo rozptylováno.

Objektiv (O) zobrazuje světlo přes zrcátko (Z1) na difrakční mřížku (DM), která je
použita jako dělič světelného svazku a je vyrobená litograficky se 150 vrypy na milimetr.
Na ní svazek difraktuje a zrcátky (Z2 a Z3) je vybrán 1. a −1. difrakční řád, které tvoří
svazky předmětové a referenční větve. Objektiv zobrazuje zdroj přes zrcátka do zadní ro-
viny kondenzorů a tím zajišťuje rovnoměrné osvětlení předmětu. Jedná se o tzv. Köhlerovo
osvětlení.

Svazek předmětové větve prochází kondenzorem (K2) a předmětem do objektivu (O2),
který předmět zobrazuje do výstupní roviny. Referenční větev má stejnou konstrukci
až na to, že mezi kondenzorem (K1) a objektivem (O1) je pouze referenční objekt. Re-
ferenční objekt a předmět by se měly v ideálním případě lišit pouze o přítomnost zobra-
zovaného předmětu. Svazky z obou větví jsou zrcátky (Z4, Z5) směrovány do výstupní
roviny, kde interferují. Takto vzniklý hologram je zobrazen pomocí výstupního objektivu
umístěného za výstupní rovinou na čip CCD kamery. Funkcí objektivu je zvětšit obraz
tak, aby byly interferenční proužky rozlišitelné kamerou.

3.2. Práce s mikroskopem

Před samotným měřením je nezbytné nastavit mikroskop pro pozorování – nastavit in-
terferenci předmětové a referenční vlny. Pro usnadnění lze nejdříve zaostřit na difrakční
mřížku bez vzorku, poté zaostřit obě větve. Jednotlivé větve se zaostřují zvlášť, nejdříve
je předmětová větev zavřena a větev referenční se zaostřuje a naopak. Zaostřuje se buď
na okraj mřížky, nebo na různé nečistoty, které se na mřížce obvykle vyskytují a které
usnadňují posouzení ostrosti. Poté jsou obrazy skládány na sebe a po přizpůsobení op-
tické délky předmětové větve je dosaženo interference. Komůrky, které obsahují stejné
médium, jsou následně vloženy do větví mikroskopu. Komůrka, která se vkládá do před-
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3. MIKROSKOP CCHM

mětové větve, obsahuje navíc kromě média i samotné vzorky (buňky). Proces zaostřování
je s komůrkami zopakován. V programu CCHM2, vytvořeném L. Kvasnicou, se nastaví
parametry (interval snímání, průměrování etc.), a poté je možné zahájit samotné snímání.
Program CCHM2 ukládá data, která následně zpracovává a zobrazuje. Dokáže v reálném
čase zobrazit obrazy amplitudy, intenzity, navázané fáze a také hologramy, které samotné
stačí na rekonstrukci a analýzu obrazu.

Obrázek 3.1: Optické uspořádání koherencí řízeného holografického mikroskopu: M – mat-
nice, C – clony, IF – interferenční filtr, O, O1 a O2 – objektivy, Z1-Z5 – zrcátka, DM –
difrakční mřížka, K1 a K2 – kondenzory. Převzato z [11].
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3.3. Zpracování hologramu

Zpracování hologramů probíhá v programu CCHM2. Aby nebyl při snímání počítač za-
tížen, bylo možné nastavit hodnoty prahování, a aby bylo celkové zpracování pod lepší
vizuální kontrolou, zpracování probíhalo v offline módu. K rekonstrukci obrazu je pou-
žíváno fourierovských metod, díky kterým je z hologramu vypočten obraz amplitudy,
intenzity a nenavázané fáze. Více o rekonstrukčním algoritmu a podmínkách je napsáno
v [1], [2]. V případě, že se zkoumají průhledné vzorky, klíčovou veličinou pro vyhodnocení
snímků je změna fáze světla, a proto je dále zpracováván obraz nenavázané fáze. Jelikož se
jedná o funkci periodickou, objevují se v obraze skoky, které se dají odstranit přičtením
nebo odečtením 2πn, kde n je celé číslo. Takto upravený obraz se označuje jako obraz
navázané fáze.

Fázový rozdíl světelných svazků procházejících referenční a předmětovou větví je přímo
úměrný rozdílu jejich optických drah:

∆Φ(x, y) = Φp(x, y)− Φr(x, y) =
2π

λ
OPD(x, y), (3.1)

kde ∆Φ je fázový rozdíl světelných svazků, Φr fáze světelného svazku procházející refe-
renční větví, Φp fáze světelného svazku procházející předmětovou větví, λ je vlnová délka
světla ze zdroje a OPD je rozdíl optických drah. OPD je dán indexem lomu a tloušťkou
vzorku. V ideálním případě, kdy se jedná o dvě identické komůrky se vzorkem o tloušťce
t (obrázek 3.2), je OPD dán pouze rozdílem indexů lomu vzorku nvz a prostředí nm a je
roven:

OPD(x, y) = [nm(h− t(x, y)) + nvz(x, y)t(x, y)]− (nmh)

= (nvz − nm)t(x, y) = ∆n(x, y)t(x, y), (3.2)

kde OPD je rozdíl optických drah, nm index lomu média, nvz index lomu vzorku,
t tloušťka vzorku, h je výška komůrky a ∆n je rozdíl indexů lomu.
Po dosazení výrazu (3.2) do rovnice (3.1):

∆Φ(x, y) =
2π

λ
(nvz − nm)t(x, y) =

2π

λ
∆n(x, y)t(x, y). (3.3)

Obrázek 3.2: Znázornění optických drah v referenční a předmětové větvi mikroskopu
CCHM; nm – index lomu média, nvz – index lomu vzorku, t – tloušťka vzorku, h – výška
komůrek.
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4. VÝZNAM OBRAZOVÉ FÁZE

4. Význam obrazové fáze
V následující kapitole jsou uvedeny dva přístupy objevující se v dostupné literatuře

k přepočtu fázového posuvu způsobeného buňkou na hodnoty ekvivalentu suché hmoty
[12]. Fázovým posuvem se již rozumí posuv fáze navázané. Dále jsou zde uvedeny kon-
krétní přepočty fáze na suchou hmotu. Suchou hmotou se rozumí bezvodný obsah buňky
(proteiny, lipidy, sacharidy).

4.1. Homogenní typ buněk

První přístup [13],[14],[15] platí především pro homogenní typ buněk, jako jsou například
červené krvinky. Buňka je aproximována jedinou hodnotou indexu lomu, protože indexy
lomu jednotlivých částí jsou téměř stejné (nb

∼= 1, 395). Pak fázový obraz odpovídá sku-
tečnému tvaru buňky a hodnota zpoždění fáze ∆Φ je přímo přepočtena na výšku buňky
t:

∆Φ(x, y) =
2π

λ
(nb − nm)t(x, y). (4.1)

Ve vztahu 4.1 představuje ∆Φ fázový rozdíl, λ vlnovou délku světla zdroje, t tloušťku
buňky, nb index lomu buňky a nm index lomu média.

Červené krvinky jsou nejběžnější krevní buňky, u savců se vyskytují bez jádra v bi-
konkávním tvaru (obrázky 4.1(a), (b)). Jejich výška se pohybuje okolo 2 µm [16].

(a) (b)

Obrázek 4.1: (a) Ilustrační obrázek červené krvinky vytvořený pomocí elektronového mi-
kroskopu. Převzato z [17], (b) Fázový profil červené krvinky vytvořený z měření na holo-
grafickém mikroskopu. Převzato z [18].

4.2. Heterogenní typ buněk

V druhém přístupu [13],[19],[20], který platí pro heterogenní typ buněk obsahující or-
ganely s různými indexy lomu, je hodnota fáze interpretována jako hustota buňky a její
změny. Tvar buněk neodpovídá fázovému obrazu. V tabulce 4.1 jsou uvedeny indexy lomu
některých složek buňky.
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Složka buňky cytoplazma jádro melanin mitochondrie
Index lomu n 1,37 1,39 1,70 1,42

Tabulka 4.1: Tabulka indexů lomu pro některé složky buňky, převzato z [21].

Na mírně nehomogenní typ buněk lze aplikovat první přístup, kdy jsou hodnoty indexů
aproximovány jedinou hodnotou a hodnoty fáze jsou přepočteny na přibližnou výšku
buňky. Typické hodnoty indexů lomu buněčných složek se pohybují v intervalu
1,37 – 1,41 [21].

Refrakční vlastnosti buňky vykazují vysokou závislost na celkové koncentraci suché
hmoty buňky [3]:

n(x, y) = n0 + αC(x, y), (4.2)

kde n0 je index lomu média, C je koncentrace suché hmoty v buňce a je vyjádřena jako
hmotnost na jednotku objemu roztoku (v g/ml), parametr α je specifický refrakční pří-
růstek (v ml/g). Různé složky buňky mají odlišné hodnoty refrakčního přírůstku α (viz
tabulka 4.2).

Složka buňky lipidy proteiny DNA hemoglobin
Refrakční přírůstek α [ml/g] 0,14 0,18 0,18 0,19

Tabulka 4.2: Tabulka specifických refrakčních přírůstků pro některé složky buňky, pře-
vzato z [22].

Biologické vzorky (buňky) jsou složené především z proteinů, nukleových kyselin a kar-
bohydrátů. Každá z těchto makromolekul je složena převážně z lehkých atomů jako jsou
například uhlík, kyslík a vodík. Elektrony v lehkých atomech interagují se světlem po-
dobným způsobem. Protože specifické refrakční přírůstky charakterizují stupeň interakce
se světlem, jsou specifické refrakční přírůstky makromolekul velmi podobné [22]. Jejich
typické hodnoty se pohybují v rozmezí 0,18 – 0,21 ml/g. Protože se tyto hodnoty příliš
neliší, jejich rozdíly lze zanedbat, a proto je zpoždění fáze přímo úměrné suché hmotě
buňky. I další geometrické parametry (obsah buněčné plochy, objem buňky, kulatost, šik-
most, špičatost) lze obdržet přímo ze zpoždění fáze, aniž by bylo nutné oddělit index lomu
a výšku buňky [12].

4.2.1. Přepočty fáze na suchou hmotu

V roce 1952 zjistili H. G. Davies a M. H. F. Wilkins [3], že buněčná interferometrie
umožňuje kvantitativně pozorovat růst buněk a další změny v průběhu jednoho buněčného
cyklu, aniž by byla živá buňka fixována nebo jinak poškozena. Rozdíl optických drah
(OPD) způsobený průchodem světelného svazku přes buňku je přímo úměrný ekvivalentu
suché hmoty. Hodnoty suché hmoty pak lze vyjádřit ze vztahu:

m =
〈OPD〉A

χ
, (4.3)

kde m představuje suchou hmotu buňky v pg, 〈OPD〉 průměrný rozdíl optických drah
v µm, A představuje buněčnou plochu v µm2 a χ specifický refrakční přírůstek v µm3 ·pg−1.
χ je rovno 100α a hodnoty α lze vyjádřit ze vztahu (4.2).
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Z tohoto vztahu (4.3) vychází všechny další uvedené přepočty, které byly nalezeny
v dostupné literatuře a liší se pouze použitou konstantou. Podle G. Popescua [13] lze (po
použití výše zmíněného vztahu 4.2) pomocí zpoždění fáze světelného svazku určit plošnou
hustotu suché hmoty.

σ(x, y) =
λ

2πα
∆Φ(x, y), (4.4)

kde σ představuje plošnou hustotu suché hmoty v pg ·µm−2, λ vlnovou délku zdroje v µm,
α specifický refrakční přírůstek v µm3 · pg−1 a ∆Φ fázový rozdíl v radiánech.

Z průměrné hodnoty plošné hustoty suché hmoty lze již snadno určit samotnou hod-
notu suché hmoty.

m = 〈σ〉A =
λ

2πα
〈∆Φ〉A, (4.5)

kde m představuje suchou hmotu buňky v pg, 〈σ〉 průměrnou plošnou hustotu suché
hmoty v pg · µm−2, A plochu buňky v µm2, λ vlnovou délku zdroje v µm, α specifický
refrakční přírůstek v µm3 · pg−1 a 〈∆Φ〉 průměrný fázový rozdíl v radiánech.

Další přepočet uvádí G. Dunn a D. Zicha [23], podle kterých lze suchou hmotu vyjádřit
následovně:

m = 〈Φ〉Aβ. (4.6)

Ve vzorci (4.6) m představuje suchou hmotu buňky v pg, 〈Φ〉 průměrný fázový posuv
v radiánech, A buněčnou plochu v µm2 a β udává množství hustoty suché hmoty
(v pg ·µm−2), které způsobí fázové zpoždění rovné jedné vlnové délce použitého světla.
V článku [23] je předpokládána přímá úměra mezi vlnovou délkou a plošnou hustotou
a pro vlnovou délku 546 nm je uvedena hodnota β = 3 pg ·µm−2. V této práci se však
používá zdroj s vlnovou délkou 650 nm, proto je nutné hodnotu hustoty pro tuto vlnovou
délku přepočítat.

4.2.2. Aplikace vzorců

Pro ověření výše uvedených vztahů (4.3) až (4.6) byly provedeny výpočty suché hmoty
buňky pro modelovou situaci s parametry uvedenými v tabulce 4.3.

Vlnová délka zdroje λ = 650 nm
Průměrný celkový fázový posuv 〈Φ〉 = 1,95 rad
Průměrný rozdíl optických drah 〈OPD〉 = 0,202 µm
Plocha buňky A = 225 µm2

Tabulka 4.3: Tabulka hodnot použitých pro přepočet fáze na suchou hmotu.

1. Přepočet podle H. G. Daviese [3]

χ = 0, 18 µm3 ·pg−1

m [pg] =
〈OPD〉[µm]A [µm2]

χ [µm3 · pg−1]
=

0, 202 · 225

0, 18
[pg] = 252, 5 pg
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2. Přepočet podle G. Popescua [13]

α = 0, 2 µm3 · pg−1

σ [pg·µm−2] =
λ [µm]

2πα [µm3 · pg−1]
〈Φ〉[rad] =

650 · 10−3

2π · 0, 2
·1, 95 [pg ·µm−2] = 1, 1208 pg ·µm−2

m [pg] = 〈σ〉 [pg · µm−2]A [µm2] = 1, 1208 · 225 [pg] = 252, 2 pg

3. Přepočet podle G. Dunna a D. Zichy [23]

λ = 546 nm . . . . . . . . . . . . . . . β = 3 pg · µm−2

λ = 650 nm . . . . . . . . . . . . . . . β = 3, 571 pg · µm−2

m [pg] =
〈Φ〉[rad]

2π
A [µm2]β [pg · µm−2] =

1, 95

2π
· 225 · 3, 571 [pg] = 249, 4 pg

4.2.3. Shrnutí

V tabulce 4.4 jsou uvedené výsledky přepočtů fáze na suchou hmotu podle jednotlivých
přístupů. Získané výsledky odpovídají biologickým předpokladům.

přepočet podle H. G. Daviese a M. H. F. Wilkinse m = 252,5 pg
přepočet podle G. Popescua m = 252,2 pg
přepočet podle G. Dunna a D. Zichy m = 249,4 pg

Tabulka 4.4: Tabulka výsledných hodnot suché hmoty získaných z modelových výpočtů.

Protože se tyto hodnoty suché hmoty od sebe příliš neliší, a protože v poslední době
je nejvíce citován přepočet podle G. Popescua, i v této práci bude dále používán právě
tento přepočet:

M = 〈σ〉A =
λ

2πα
〈∆Φ〉A. (4.7)
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5. Experiment s buňkami K2
V následující kapitole je nejdříve obecně popsána kultivace buněk, následně příprava

experimentů, zpracování a vyhodnocení naměřených dat a nakonec jsou představeny vý-
sledky jednotlivých měření, ve kterých bylo cílem pozorovat změny suché hmoty buněk.
Celkem byla provedena čtyři měření. V prvních dvou případech byl proveden experiment
nutriční deprivace buněk, kdy buňky neměly dostatek živin a v důsledku toho ztrácely
na suché hmotě. Ve druhých dvou případech byl proveden opačný experiment – růst
buněk, kdy buňky měly dostatek živin, a proto mohly během snímání dále růst. Jako
vzorky byly použity nádorové nemetastazující embryonální fibroplasty inbredního potkana
Louis Lewis. Tyto buňky jsou označovány jako K2 (plné označení LW13K2) a byly kulti-
vovány v laboratoři Experimentální biofotoniky na ÚFI FSI VUT v Brně. Všechna měření
probíhala na holografickém mikroskopu CCHM. Tento mikroskop je neustále softwarově
i konstrukčně vyvíjen, mezi prvním a druhým měřením byl například změněn způsob
vyhřívání boxu a byly vylepšeny posuvy stolků.

5.1. Příprava experimentu

5.1.1. Kultivace buněk

Buněčné linie jsou dlouhodobě uchovávány v zamraženém stavu v kapalném dusíku.
Buněčné linie, které jsou aktuálně používané k experimentům, jsou kultivovány v kul-
tivačních lahvičkách v inkubátoru Sanyo MCO–18AIC při ideální teplotě pro jejich růst
37◦C s 3,5% koncentrací CO2. Při kultivaci buněk je nutné pracovat ve sterilním pro-
středí a udržovat celkovou čistotu. Proto veškerá manipulace probíhá ve flow-boxu MSC
Advantage, ve kterém je díky proudění vzduchu zabráněno vzniku případné kontaminace.

Buňky K2 byly pěstovány v kultivačním médiu uchycené na povrch kultivační lahvičky
v inkubátoru. Ke kultivaci buněk bylo použito médium M1H, které bylo obohaceno o fe-
tální telecí sérum (FTS), které slouží jako živiny pro buňky. Celkové složení média M1H
k nalezení v [2]. Kultivační médium bylo nezbytné jednou za určitou dobu vyměnit. V mo-
mentě, kdy buňky vytvořily konfluentní porost, bylo potřeba je ztrypsinizovat. V tomto
procesu dochází k oddělení buněk od povrchu, popis tohoto procesu je detailně popsán
v [24]. Po provedení trypsinizace byly buňky přepočítány v Brücknerově komůrce v mik-
roskopu s fázovým kontrastem. Určitý počet buněk (cca 20 000) byl vložen do kultivační
lahvičky, která byla následně doplněna médiem a takto připravená suspenze se mohla dále
kultivovat. Ostatní buňky jsou udržovány ve zkumavkách ve stavu suspenze v lednicích
při teplotě 5◦C (řádově několik dní) a slouží k přípravě vzorků pro experimenty.

Růst buněk byl kontrolován v klasickém fázovým kontrastu (obrázek 5.1) a v diferen-
ciálním interferenčním kontrastu (obrázek 5.2).

13



5.1. PŘÍPRAVA EXPERIMENTU

(a) (b)

Obrázek 5.1: Buňky K2 v klasickém fázovém kontrastu při použití objektivu se zvětšením
(a) 20× a (b) 40×.

Obrázek 5.2: Buňky K2 v diferenciálním interferenčním kontrastu při použití objektivu
se zvětšením 20×.

5.1.2. Příprava vzorku pro pozorování

Buňky byly nasazeny do komůrek a vloženy do inkubátoru (koncentrace 12 buněk na mm2).
Po dvou dnech kultivace buněk v inkubátoru bylo v prvních dvou měřeních médium M1H
vyměněno za fyziologický roztok HBBS (z anglického výrazu Hanks Balanced Salt Solu-
tion). Buňky v roztoku HBBS nemají dostatek živin, a proto začnou hladovět. Do před-
mětové komůrky byly vloženy buňky v roztoku HBBS, v referenční komůrce byl jen roztok
HBBS.

Ve třetím a čtvrtém měření bylo médium M1H vyměněno za médium F10, které má
téměř stejné složení jako M1H, pouze neobsahuje pH indikátor fenolovou červeň. Médium
F10 je více transparentní a obsahuje telecí sérum (FTS), a proto jsou v něm buňky lépe
viditelné a mají v něm dostatek živin pro další růst. Do předmětové komůrky byly vloženy
buňky s médiem F10, do referenční komůrky bylo vloženo pouze médium F10.

Poté, co byly připraveny příslušné komůrky pro jednotlivé experimenty, byly komůrky
vloženy do referenční a předmětové větve mikroskopu CCHM. Schéma komůrky je na ob-
rázku 5.3.
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5. EXPERIMENT S BUŇKAMI K2

Obrázek 5.3: Stacionární komůrka je složena ze dvou krycích sklíček o tloušťce 0,17 mm
a kovového mezikruží. Spodní krycí sklíčko je napevno přilepeno ke kovovému mezikruží,
horní krycí sklíčko je po nasazení buněk přichyceno vazelínou.

5.2. Zpracování naměřených dat

Z hologramů lze pomocí programu CCHM2 získat nenavázanou fázi, ze které lze poté
získat fázi navázanou. Analýza navázané fáze probíhala v programu ImageJ (obrázek
5.4).

Obrázek 5.4: Panel nástrojů programu ImageJ.

5.2.1. ImageJ

Program ImageJ je volně dostupný program určený pro zpracování a analýzu obrazu. Pro-
gram dokáže zobrazovat a zpracovávat 8-, 16- a 32-bitové obrazy a také pracovat s mnoha
obrazovými formáty – TIFF, JPEG, RAW atd. Podporuje zobrazení sérií obrazů v jednom
okně i jejich sériovou analýzu. Program umožňuje počítat plošné statistiky v definovaném
výběru. Umožňuje měřit vzdálenosti a úhly, dokáže vytvořit histogramy a čárové profily,
podporuje standardní funkce zpracování obrazu jako jsou logické a aritmetické operace
mezi obrazy, manipulace s kontrastem, Fourierovy analýzy, ostření, vyhlazování, detekce
hran a mediánové filtrování. Program podporuje také zobrazení většího počtu oken sou-
časně. Více v [25].

5.2.2. Analýza dat

Snímky navázané fáze (obrázek 5.5(a)) byly otevřeny příkazem Image sequence (File
⇒ Import ⇒ Image sequence). Poté byl upraven kontrast pro lepší vizuální kontrolu
(Image ⇒ Adjust ⇒ Brightness/Contrast). Protože byl používán 32-bitový formát TIFF,
který uchovává pouze čísla, operace Brightness/Contrast změnila jen zobrazení. Protože
se ve všech případech měření jednalo o dlouhodobá časová pozorování, kdy buňka zůstává
na stejném místě mřížky, byly také pořízeny snímky pozadí. Pozadím se rozumí snímek,
na kterém se nenacházejí buňky. Tyto snímky byly pak v programu ImageJ odečteny
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od snímků s buňkami (Process ⇒ Image calculator). Dále bylo potřeba buňku odpraho-
vat od pozadí (Image⇒ Adjust⇒ Threshold). Hodnota prahování byla získána empiricky
a zkontrolována pomocí histogramu (Analyze ⇒ Histogram), který je vidět na obrázku
5.5(b). Na bimodálním histogramu (pro objekt a pozadí) je hodnota prahování vybrána
z lokálního minima ležícího mezi dvěma píky histogramu. Výsledkem prahování je obraz,
na kterém je červenou barvou označena buňka a černou barvou je označeno pozadí.

(a) (b)

Obrázek 5.5: (a) Snímek navázané fáze buňky, (b) histogram použitý při kontrole hodnoty
prahování.

V dalším kroku byla buňka označena příkazem Freehand selections tak, aby na všech
snímcích byla celá buňka uvnitř označené oblasti, ve které bude probíhat analýza. Od-
prahovaná a označená buňka je zobrazena na obrázku 5.6(a). Poté bylo možné spustit
samotnou analýzu (Analyze ⇒ Analyze particles). Výstupy těchto měření byly nastaveny
v Analyze set measurements. V našem případě byla jako výstup zvolena pouze suma cel-
kové fáze buňky (Integrated Density). Tyto hodnoty lze zobrazit v samostatném okně
Results. Zároveň lze vykreslit i hranici buňky (obrázek 5.6(b)). Hodnoty celkové fáze byly
dále vyhodnocovány.

(a) (b)

Obrázek 5.6: (a) Odprahovaná a ohraničená buňka, (b) vykreslená hranice buňky
v průběhu analýzy dat v programu ImageJ.
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5.2.3. Vyhodnocení

Pomocí programu ImageJ byly získány hodnoty celkové fáze ∆Φ. Jedná se o součet hodnot
v jednotlivých pixelech (p), které byly označeny jako buňka:

∆Φ =
∑
ij

∆Φi,j = 〈∆Φ〉p. (5.1)

Při použití objektivů se zvětšením 10× plocha Ap = 0, 2 µm2 odpovídá 1 pixelu,
a proto bylo potřeba hodnoty získané pomocí programu ImageJ vynásobit číslem 0,2.
Plocha buňky A je rovna:

A = pAp. (5.2)

Po dosazení předchozích vztahů 5.1 a 5.2 byly získané hodnoty celkové fáze na plochu
přepočteny na hodnoty ekvivalentu suché hmoty podle již uvedeného vzorce od
G. Popescua (4.7).

M =
λ

2πα

∆Φ

p
pAp =

λ

2πα
∆ΦAp, (5.3)

kde M představuje hodnoty ekvivalentu suché hmoty, λ vlnovou délku zdroje, α spe-
cifický refrakční přírůstek, ∆Φ hodnoty celkové fáze a Ap plochu pixelu.

5.3. Nutriční deprivace

V tomto experimentu byla pozorována nutriční deprivace buněk. Jednalo se o dlouhodobé
snímání buněk K2 v roztoku HBBS, ve kterém bylo cílem na náhodně vybrané buňce po-
zorovat úbytek suché hmoty. Buňky se nacházely v roztoku HBBS, který neobsahoval
živiny. První měření probíhalo po dobu 18 hodin s intervalem snímání 60 s, druhé měření
probíhalo 30 hodin s intervalem snímání 120 s. Druhé snímání bylo zahájeno až 5 ho-
din poté, co byly buňky s médiem vloženy do komůrky a do příslušné větve mikroskopu,
na rozdíl od prvního snímání, které bylo spuštěno ihned. Během snímání nebyl mikroskop
po celou dobu ideálně naladěn a zvýšený šum v důsledku rozladění znemožňoval automa-
tickou detekci hranice mezi buňkou a okolím, proto bylo nutné data vizuálně kontrolovat
a vzhledem k velkému počtu dat byl pro vyhodnocení použit každý desátý získaný snímek
(hologram).

5.3.1. První měření

Parametry pozorování a nastavení mikroskopu

Před měřením byl mikroskop nastaven stejným způsobem, jak bylo uvedeno v sekci 3.2.
Během prvního pozorování byla udržována teplota na hodnotě 37◦C (optimální teplota
pro buňky). Pro dosažení a ustálení této teploty byly na holografickém mikroskopu za-
pnuty dva topné systémy přibližně o dva dny dříve. První systém vyhřívá podstavec pod
mikroskopem (žulová deska) a tím vytváří stabilní teplotní gradient uvnitř termoizolač-
ního boxu obklopujícího mikroskop. Aby vzduch dosáhl teploty okolo 30◦C, byla deska
zahřívána na 67◦C. Druhý topný systém ohřívá posuvný stolek se vzorkem, a proto zde
byla nastavena přímo teplota 37◦C.
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5.3. NUTRIČNÍ DEPRIVACE

V tomto experimentu byly použity objektivy se zvětšením 10×, s numerickou aper-
turou NA = 0, 25, filtr s maximální propustností na vlnové délce λ = 650 nm a clona
s průměrem 3 mm. Jednalo se o časosběrné snímání s intervalem 60 sekund a průměro-
váním 3 snímků za sekundu. Důležité parametry nastavení experimentu jsou shrnuty
v tabulce 5.1.

Objektivy 10×, numerická apertura NA = 0,25
Clona průměr 3 mm

Filtr
max. propustnost na λ = 650 nm

pološířka maxima 10 nm
Průměrování 3 snímky
Interval snímání 60 s
Teplota podstavce 67◦C
Teplota stolku 37◦C

Tabulka 5.1: Tabulka důležitých parametrů při pozorování v prvním měření.

Výsledky prvního měření

Hodnoty celkové fáze byly přepočteny na hodnoty suché hmoty. V tabulce 5.2 jsou uvedeny
výsledky prvního měření ve vybraných časových okamžicích. Data byla vynesena do grafu
5.7. Tento graf zaznamenává úbytek suché hmoty v závislosti na čase. Jednotlivé body
představují hodnoty suché hmoty, které jsou proložené klouzavým průměrem. V grafu jsou
čerchovanými čarami také zaznamenány okamžiky, ve kterých byl mikroskop kontrolován
a případně dolaďován.

τ [min] 〈Φ〉·Ac [rad·µm2] M [pg]

0 950 546
100 917 527
200 901 518
300 893 513
400 880 505
500 851 489
600 791 455
700 789 454
800 773 447
900 762 438
1000 768 441

Tabulka 5.2: Tabulka hodnot sumy celkové fáze (〈Φ〉·Ac) a suché hmoty (M) pro vybrané
časové okamžiky v prvním měření.
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Obrázek 5.7: Závislost úbytku suché hmoty na čase v prvním měření. Jednotlivé body
představují hodnoty suché hmoty, které jsou proložené křivkou. Tato křivka vznikla
klouzavým průměrem na tyto hodnoty. Čerchované čáry označují časy, kdy proběhlo do-
laďování mikroskopu.

5.3.2. Druhé měření

Parametry pozorování
’

nastavení mikroskopu

Mikroskop byl před měřením nastaven klasickým způsobem (sekce 3.2). Optimální teplota
pro buňky okolo 37◦C byla udržována pomocí termostatem regulované cirkulace teplého
vzduchu, který ohřívá celý prostor uvnitř termoizolačního boxu CCHM. Aby se tato tep-
lota ustálila, bylo ohřívání spuštěno 12 hodin před zahájením experimentu. I v tomto ex-
perimentu byly použity objektivy se zvětšením 10×, s numerickou aperturou NA = 0, 25,
filtr s maximální propustností na vlnové délce λ = 650 nm a clona s průměrem 3 mm.
Jako interval snímání byl zvolen čas 120 sekund s průměrováním 3 snímků za sekundu.
Tyto parametry jsou shrnuty v tabulce 5.3.

Objektivy 10×, numerická apertura NA = 0, 25
Clona průměr 3 mm

Filtr
max. propustnost na λ = 650 nm

pološířka maxima 10 nm
Průměrování 3 snímky
Interval snímání 120 s
Teplota termostatu 36,6◦C

Tabulka 5.3: Tabulka důležitých parametrů při pozorování v druhém měření.
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Výsledky druhého měření

V tabulce 5.4 jsou uvedeny výsledky druhého měření pro vybrané okamžiky. Je zde za-
znamenán přepočet hodnot celkové fáze na plochu na hodnoty suché hmoty. V grafu
na obrázku 5.8 je zaznamenán úbytek suché hmoty v závislosti na čase. Jednotlivé body
představují hodnoty suché hmoty. Tyto body jsou proložené křivkou, která vznikla klouza-
vým průměrem hodnot suché hmoty. V grafu jsou čerchovanými čarami zaznamenány
okamžiky, ve kterých byl mikroskop kontrolován a dolaďován.

τ [min] 〈Φ〉·Ac [rad·µm2] M [pg]

0 824 426
100 758 392
200 724 375
300 729 377
400 718 371
500 713 368
600 718 371
700 710 367
800 698 361
900 661 342
1000 650 336
1100 646 334
1200 665 344
1300 664 343
1400 656 339
1500 642 332
1600 614 317
1700 584 302

Tabulka 5.4: Tabulka hodnot sumy celkové fáze (〈Φ〉·Ac) a suché hmoty (M) pro vybrané
časové okamžiky v druhém měření.
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Obrázek 5.8: Závislost úbytku suché hmoty na čase v druhém měření. Jednotlivé body
představují hodnoty suché hmoty, které jsou proložené křivkou. Tato křivka vznikla apli-
kací klouzavého průměru na tyto hodnoty. Čerchované čáry označují časy, kdy probíhalo
dolaďování mikroskopu.

5.3.3. Shrnutí

V obou experimentech byla pozorována náhodně vybraná buňka, na které byl sledován
úbytek suché hmoty, když buňce nebyl poskytnut dostatek živin. Z grafů na obrázcích
5.7 a 5.8 je patrný úbytek suché hmoty v závislosti na čase. Větší skoky byly způsobeny
rozladěním mikroskopu, v důsledku kterého se zvýšil i šum. Šum znemožnil přesnou de-
tekci hranice mezi buňkou a pozadím, a proto vypočtené hodnoty celkové fáze (resp. suché
hmoty) přesně nekopírují teoretickou klesající závislost. V prvním měření mohlo být da-
lším důvodem rozlaďování mikroskopu i nefunkčnost nastaveného průměrování. V druhém
měření mohlo být rozladění zapříčiněno vypnutím ohřevu systému ke konci snímání (cca
10 min), čímž se snížila teplota – z ideální teploty pro buňky 37◦C na 35◦C.

5.4. Růst buněk

Ve třetím a čtvrtém měření byl sledován růst buněk. Jednalo se o dlouhodobé snímání
buněk K2 v médiu F10, ve kterém bylo cílem na náhodně vybrané buňce pozorovat růst
buněčné hmoty v závislosti na čase. Třetí měření probíhalo 13 hodin s intervalem snímání
60 s, čtvrté 13 hodin s intervalem snímání 120 s. Ke zpracování byl v obou případech
použit každý desátý snímek.
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5.4.1. Třetí měření

Parametry pozorování

V tomto experimentu byla udržována ideální teplota pro buňky okolo 37◦C pomocí cir-
kulace teplého vzduchu. Byly použity objektivy se zvětšením 10× a s numerickou aper-
turou NA = 0, 25, filtr s maximální propustností na vlnové délce λ = 650 nm a clona
s průměrem 1 mm. Jako interval snímání byl zvolen čas 60 sekund s průměrováním
3 snímků za sekundu. Důležité parametry experimentu jsou shrnuty v tabulce 5.5.

Objektivy 10×, numerická apertura NA = 0, 25
Clona průměr 1 mm

Filtr
max. propustnost na λ = 650 nm

pološířka maxima 10 nm
Průměrování 3 snímky
Interval snímání 60 s
Teplota termostatu 36,6◦C

Tabulka 5.5: Tabulka důležitých parametrů při pozorování ve třetím měření.

Výsledky

V tabulce 5.6 jsou uvedeny výsledky třetího měření pro vybrané časové okamžiky. Je zde
zaznamenán přepočet hodnot celkové fáze na hodnoty suché hmoty a v grafu na obrázku
5.9 je zaznamenán růst suché hmoty v závislosti na čase. Jednotlivé body představují
hodnoty suché hmoty, které jsou proložené klouzavým průměrem. V grafu jsou také čer-
chovanými čarami zaznamenány okamžiky, ve kterých byl mikroskop kontrolován.

τ [min] 〈Φ〉·Ac [rad·µm2] M [pg]

0 1100 632
100 1115 641
200 1226 705
300 1285 739
400 1367 786
500 1404 807
600 1426 820
700 1483 852
800 1484 853

Tabulka 5.6: Tabulka hodnot sumy celkové fáze (〈Φ〉·Ac) a suché hmoty (M) pro vybrané
časové okamžiky ve třetím měření.
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Obrázek 5.9: Závislost suché hmoty na čase ve třetím měření. Jednotlivé body představují
hodnoty suché hmoty, které jsou proložené křivkou. Tato křivka vznikla aplikací klouza-
vého průměru na tyto hodnoty. Čerchované čáry označují časy, kdy probíhala kontrola
mikroskopu.

5.4.2. Čtvrté měření

Parametry pozorování

V průběhu tohoto experimentu byla udržována teplota okolo 37◦C pomocí 2 topných sys-
témů, které vyhřívaly podstavec pod mikroskopem (žulovou deska) a posuvný stolek s ko-
můrkami. Byly použity objektivy se zvětšením 10× a s numerickou aperturou NA = 0, 25,
filtr s maximální propustností na vlnové délce λ = 650 nm a clona s průměrem 1 mm.
Jako interval snímání byl zvolen čas 120 sekund s průměrováním 3 snímků za sekundu.
Důležité parametry experimentu jsou shrnuty v tabulce 5.7.

Objektivy 10×, numerická apertura NA = 0, 25
Clona průměr 1 mm

Filtr
max. propustnost na λ = 650 nm

pološířka maxima 10 nm
Průměrování 3 snímky
Interval snímání 120 s
Teplota podstavce 67◦C
Teplota stolku 37◦C

Tabulka 5.7: Tabulka důležitých parametrů při pozorování ve čtvrtém měření.
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5.4. RŮST BUNĚK

Výsledky

Výsledky čtvrtého měření pro vybrané časové okamžiky jsou uvedeny tabulce 5.8. V této
tabulce je zaznamenán přepočet celkové fáze na suchou hmotu a v grafu na obrázku 5.10
je zaznamenán růst suché hmoty v závislosti na čase. Na rozdíl od předchozích snímání
nemusel být mikroskop dolaďován.

τ [min] 〈Φ〉·Ac [rad·µm2] M [pg]

0 894 514
100 959 551
200 999 574
300 1105 635
400 1436 826
500 1580 908
600 1739 999
700 1858 1068
800 1937 1113

Tabulka 5.8: Tabulka hodnot sumy celkové fáze (〈Φ〉·Ac) a suché hmoty (M) pro vybrané
časové okamžiky ve čtvrtém měření.

Obrázek 5.10: Závislost suché hmoty na čase ve čtvrtém měření. Jednotlivé body před-
stavují hodnoty suché hmoty, které jsou proložené křivkou. Tato křivka vznikla aplikací
klouzavého průměru na tyto hodnoty.

24



5. EXPERIMENT S BUŇKAMI K2

5.4.3. Shrnutí

V těchto dvou experimentech byla pozorována náhodně vybraná buňka, na které byl
pozorován růst suché hmoty v situaci, kdy buňce bylo poskytnuto dostatek živin a buňka
mohla dále růst i během snímání. Z grafů na obrázcích 5.9, 5.10 je patrný růst suché hmoty
v závislosti na čase. Větší skoky byly způsobeny rozladěním mikroskopu. Ve třetím měření
byly dalším důvodem skoků v hodnotách celkové fáze (resp. suché hmoty) i nečistoty,
které byly obsaženy v médiu F10. Médium nebylo před snímáním přefiltrováno, proto
obsahovalo nečistoty z FTS. Ve čtvrtém měření se nečistotám předešlo přefiltrováním
média před snímáním.
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6. Závěr
V první polovině teoretické části bylo pojednáno nejdříve o historii holografické mi-

kroskopie, poté o vývoji holografie na ÚFI FSI VUT v Brně (kapitola 2) a následně
o transmisním holografickém mikroskopu použitém k experimentům této práce, včetně
jeho konstrukčního popisu (kapitola 3). V této kapitole bylo také pojednáno o zpracování
hologramu (sekce 3.3).

Ve druhé polovině teoretické části byl popsán význam obrazové fáze (kapitola 4). Byly
zde uvedeny 2 přístupy k interpretaci fázového posuvu způsobeného buňkou (sekce 4.1
a 4.2). První platí pro homogenní typ buněk (stejný index lomu pro všechny části buňky)
a hodnotu zpoždění fáze lze přímo přepočítat na výšku buňky. Druhý přístup platí pro
heterogenní typ buněk (různé indexy lomu), kdy je hodnota fáze interpretována jako
hustota buňky a její změny. Některé další parametry jakou je i suchá hmota buňky lze
obdržet přímo ze zpoždění fáze, aniž by bylo potřeba oddělovat index lomu od tloušťky
buňky.

V závěru teoretické části bylo pojednáno o přepočtech celkové fáze na suchou hmotu
(podle H. G. Daviese a M. H. F. Wilkinse, G. Popescua, G. Dunna a D. Zichy). K vý-
počtům u experimentů byl použit přepočet od G. Popescua, který ho aplikoval také na op-
tické vážení buněk a je v poslední době nejvíce citován.

Stěžejní část práce byla tvořena pozorováním živých buněk K2 (kapitola 5). Nejdříve
bylo pojednáno o kultivaci buněk, která probíhala v kultivačních lahvičkách s médiem
M1H v inkubátoru Sanyo MCO–18AIC. Dále bylo pojednáno o přípravě vzorku pro po-
zorování. Buňky s médiem byly vloženy do předmětové komůrky, samotné médium bylo
vloženo do referenční komůrky. Takto připravené komůrky již bylo možné vložit do mi-
kroskopu a pozorovat. Poté bylo v sekci 5.2 popsáno zpracování naměřených dat, které
probíhalo nejdříve v programu CCHM2 a následně v programu ImageJ. V posledních
dvou sekcích této experimentální části (sekce 5.3 a 5.4) byly představeny provedené expe-
rimenty. Ke všem měřením byl použit transmisní holografický mikroskop (CCHM) a jako
vzorky byly použity nádorové nemetastázující embryonální fibroplasty inbredního potkana
Louis Lewis označované K2 (plné označení LW13K2). Prvně byly provedeny experimenty
nutriční deprivace buněk a následně experimenty, kdy byl sledován růst buněk. Získaná
klesající (resp. rostoucí) závislost suché hmoty buněk na čase je zaznamenána v grafech
na obrázcích 5.7, 5.8, 5.9 a 5.10.

V rámci bakalářské práce byla zvládnuta problematika měření ekvivalentu suché hmoty
buněk. Ve všech experimentech (měření suché hmoty buněk) byly potvrzeny biologické
předpoklady. V případě, kdy jsou buňky ve vhodném prostředí, které jim poskytuje do-
statek živin, mohou dále růst a poté se dělit. V opačném případě buňky snižují svoji
hmotnost (resp. suchou hmotu) a při dlouhodobém nedostatku živin umírají. Změny ekvi-
valentu suché hmoty jsou důležité především v biologických aplikacích, avšak měřit je lze
jen díky různým mikroskopickým metodám. Transmisní holografický mikroskop se jeví
jako vhodný nástroj pro dlouhodobá pozorování a měření živých buněk.
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